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Agents secrets, 3 vos écrans!

Pour mieux vivre a
I'école!

En équipes, a l'aide
d’un logiciel de
présentation de son
choix (laisser les éleves
choisir), présenter

quelques reglements de

7y 'école, accompagnés

i~¥l de justifications.

o En faire la présentation

o aux autres dasses.

- gl Note : cette activité
peut se vivre en
septembre

Un courriel pour mon
enseignante

Rédiger un message
pour son enseignante
(theme déterminé par
I'enseignante).

Noél en conte
LopArt [V

+ .
Didapages [}/  ou
Publisher [}/ ou
Pages :

PowerPoint |/

ou
ou

Keynote

Reéaliser une page titre
d’un conte de Noél.
Faire le dessin dans
LopArt, 'exporter et
linsérer dans un
logiciel de mise en
page.

J'aime lire et je
I'affiche!
PowerPoint [}/  ou

Publisher /|

A I'aide d'un logiciel de
mise en page, réaliser
une affiche publicitaire
d’appréciation littéraire
d‘un livre lu.

Utiliser les fonctions
texte, lettrage et
insertion d'image.

Un valentin sonore
Audacity [

Envoyer par courriel un
valentin sonore a son
meilleur ami, réalisé a
I'aide d’Audacity et
exporté en MP3.

Bien manger, c'est
pas sorcier!

Comic Life [

Reéaliser une bande
dessinée faisant la
promotion de
ITmportance de bien
manger. Par exemple,
faire parler une boite a
godlter, des fruits ou
des légumes...

Rallye en folie!
Google earth [V

Donner aux éléves 5
adresses mystére. A
|'aide de Google Earth,
ils doivent trouver a
quoi correspondent ces
adresses. (Ex.:
I"épicerie, le restaurant,
un lieu du culte, une
bibliothéque, le poste
de police, le bureau de
poste...).

Le lutin qui danse!
Scratch [

En équipes, faire
danser le lutin. Comme
défi, les éléves suivent
le procédurier pas a
pas.
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Les outils du portfolio

@@

Canevas Informations
L J" — .
f 3

J Carte
Diaporama Musée postale

EX=,

Exportation Impression Recyclage

Astuces
‘z Pour transférer une image d’'un portfolio LopArt a un autre, appluyez sur la O3 ]1
touche majuscule avant d’appuyer sur I'icbne d’exportation. L ,J

£ Pour récupérer son dessin en format .lop, cliquez sur la majuscule puis sur la page blanche.

‘z Pour démarquer un détail ou une forme, dessiner la ligne contour apres le dessin, pour éviter de dépasser lors du
remplissage.

Suzanne Harvey - RECIT de la Commission scolaire des Chénes Page 2



Les outils de dessin du canevas

Annuler ou vijtesse
Couleurs Duo-tons Textures rétablir d’animation

l Transparence \

v

5
L
@
Niveaux de Trait Taille Animation
textures
Les textures
Niveau 1 Niveau 2
1)(2)(3)(4 1)(2)(3)(4 .
1. Gouache 7 W 1. Ecailles
I ; 2. Aquarell¢ i l‘ a'.g-_ ¥ III.f 2. Taches
3. Aérosol gt 3. Eau
e \
i 4. Cire - éq\; _ 4.
| 5. Fusain ¥ “},.e . Branches/Foin
6. Encre Ny gh Ml 5. cheveux
7. Cire : 6. Feuilles
5 6 7 8 8. Pastel 5 6 7 8 7. Ifrisous
o CAAv~A

. Ecorce

. Etoiles

. Pétales/Cercles
. Ecorce

. Guirlande

. Feuilles

elouse/Fourrure

Suzanne Harvey - RECIT de la Commission scolaire des Chénes Page 3



Les couleurs et les duo-tons

Tons de gris Couleurs Duo-tons

rw A oy

Couleur Goutte d’eau pour
sélectionnée I'estompage

% Astuce : Pour retrouver une couleur, cliquez sur celle-ci dans le canevas (sur le dessin) en enfongant la touche
majuscule. Ainsi, tous les parameétres précédemment établis se réaffichent.

Suzanne Harvey - RECIT de la Commission scolaire des Chénes Page 4



SCRAPBOOKING DIGITAL

AAAAA Avec PowerPoint

DES CHENES

1. Insérez le disque dans le lecteur et ouvrez une nouvelle présentation
(vide) PowerPoint

2. Enregistrez

3. Insérez un arriére-plan

Format > Arriére-plan...
Cliquez sur la fleche v | et sélectionnez Motifs et textures...

Onglet Image > Bouton Sélectionner une image...
Choisissez l'arriere-plan de votre choix
* Regarder dans : (cliquez sur la fleche et choisissez le disque)
» Choisissez votre theme
e Choisissez un papier (double-cliquez)
* OK
* Appliquer

4. Insérez les éléments décoratifs

Insertion

Image > A partir du fichier...

Choisissez I'image (double-cliquez)

Jouez avec lI'image (redimensionnement, rotation, etc.)
Répétez ces étapes jusqu’a ce que la page soit a votre go(t

5. Insérez des photos ou d’autres images

Assurez-vous que la barre d’outils image soit accessible
Clic droit sur I'image pour changer l‘ordre

Lorsque le montage est a votre go(t, groupez les éléments (plus facile
pour le déplacement, surtout lorsque I'on utilise des lettres).
On peut les dissocier au besoin.

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) * février 2011



6. Pour écrire du texte

Insertion > Zone de texte

Ecrivez et mettez en forme le texte (police, couleur, grosseur, etc.)
Placez la zone de texte a I’endroit voulu

Jouez avec le bloc de texte (rotation, plans, etc.)

Petits extras

1. Pour changer le format des diapositives :

Fichier > Mise en page...

Cliquez sur la fleche \ V‘ et sélectionnez Personnalisé

Ex : 30 cm X 30 cm

2. Pour faire une image de votre diapositive :

Sur la diapositive : Fichier > Enregistrer sous...
Enregistrer dans : (D ou X)

Nom de fichier :

Type de fichier > JPEG ou GIF

Diapositive en cours uniquement

*x* N'oubliez pas d’enregistrer votre travail **x*

Amusez-vous!

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) ¢ février 2011
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Enregistrement a I'aide d'un microphone

Réglez le volume d’enregistrement.

& .

Faites un essai pour vérifier les niveaux.

5 Cliquez sur le bouton Enregistrer et captez
quelques secondes de son.

N Cliquez sur le bouton Arrét pour stopper

I'enregistrement.

Trop fort

Supprimez la piste d’essai.

Enregistrez tout le texte d'un personnage, puis cliquez sur arrét. Prendre soin de laisser un
peu de silence AVANT et APRES chaque réplique.

Enregistrez autant de pistes qu'il y a de personnages. Nommez chaque piste pour vous
aider a faire votre montage.

Enregistrez le résultat: Fichier => Enregistrer sous.

;4— MH
Trop faible Correct !

X|ristert  w| 1,0]

3
3
h

Déplacer la piste vers e bas

Faorme d'onde (dE)
Spectre
Hauteur (EAC)

ATTENTION: Il y a aura un dossier (_data) de créé ainsi que deux fichiers (.aup et .bak). Si vous voulez déplacer votre

enregistrement, vous devez déEIacer ensemble le dossier ainsi gue les deux fichiers.

© Karine St-Georges
Cs des Chénes 2009



Exporter le montage en format wav ou en format mp3

Edition  Affichage Projet Generer  Effet Pour exploiter votre montage dans un autre logiciel, vous devez I'exporter
Mowrveau Chrl+H dans un format universel.
Ouwrir,.,, k40
Fermer CEEH

Enregistrer le projet sous. ..

Praojets récents, ., »

Exporter an WAY. ., < Le format wav offre la meilleure qualité sonore mais occupe beaucoup de
place sur le disque dur.

Expatter comme MP3... Le format mp3 offre une qualité sonore acceptable et divise environ par 10
I'espace nécessaire sur le disque dur. Le mp3 est le format standard d'Internet.

Exporter comme Cgg Yorbis Le format Ogg Vorbis est un format libre. Il offre une qualité sonore légére-
ment supérieure au mp3 tout en occupant un peu moins d’espace. Il faut un
logiciel spécialisé pour lire ces fichiers, mais ce logiciel est gratuit.

Export Multiple... Si vous désirez télécharger Audacity, vous pouvez aller a I'adresse suivante:
T http://audacity.sourceforge.net/
Imprimer...

Pour exporter en mp3, vous devez installer un utilitaire nommé
Quikker LAME MP3 ENCODER. Il est possible de télécharger I'utilitaire au méme en-
: : : droit que le logiciel

NG Choisir un emplacement pour le fichier,
donner un nom au fichier et enregistrer.

Dang le fichier erpaorté, vos pistes seront mélangées en deus canaux stéréa

[ Me plus montrer cet avertizeement,

0K

Cli N
CIQUCZ SUTUIN,

© Karine St-Georges 11
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Réaliser un photoroman

Avec ComicLife

Suzanne Harvey
Service local du RECIT
Commission scolaire des Chénes

recit.csdc.qc.ca Février 2009




Etape 1 : batis un Scénario

Réalisation d’un photoroman avec Comic Life e RECIT de la CSDC e Suzanne Harvey -

page 2




Etape 2 - Réalise la bande dessinée

——— — — . — - e ——————

@ Démarre Comic Life

@ Choisis un modele de page. Clique dessus et glisse-le jusque dans la page.

SN

2 o= @ & 0o&

brregsrer Bngrimer Cowder  Zeom evasl oameribie Adapier

Gt BEMT Wak FRgR FamML AN Kde

Cherche ton dossier de photos. QOuvre-le.

i3 PAIATEE TU - T =T =TT,

bas. ] l
Er wailal

Réalisation d’un photoroman avec Comic Life e RECIT de la CSDC » Suzanne Harvey - page 3




Glisse les photos dans les panneaux.
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Enregistrer Imprimer

Réalisation d’un photoroman avec Comic Life e RECIT de la CSDC e Suzanne Harvey - page 4




Google earth

1. Ouvrez Google earth.

v Recherche

Hller‘iﬂ Commerces Itinéraires }

2. Inscrivez |'adresse.
v Aller 3 Ex.:37 25,818'N, 122 05.36'0

\ 507 Lindsay, Drummonduville, qc B Q
3. Effectuez un zoom avec cet 4. Au besoin, utilisez les
outil (ou utilisez la molette données géographiques.

de la souris).

v Données géographit Galerie Google Earth »»

v [=)% Base de données primaire
> EP Frontieres et légendes
ME Lieux
= Photos
| == Routes
v Batiments 3D
Texture photo
Cubes grisés
» [F* Océan
1" Street View
%% Météo
J$% Galerie
[ Sensibilisation mondiale
2 Plus

-

vyvvyvwvyy

Mission possible en TIC  Julie Aubé et Suzanne Harvey e RECIT de la CSDC



http://scratch.mit.edu




«» B Y Fichier Edition Partage Aic

Mouvement Contrdle 47 Lutini
Apparence Capteurs
Sons Opérateurs

Stylo Variables

—
avancerds an = > avancer de pas

tourner de G degrés

tourner de & degrés

Déplace le bloc de commande avancer de ... pas
dans l'aire des scripts.

rclil &b | 3D Fichier Edition Partage Aide

Mouvement Contrdle \ @ Lutinl

Apparence Capteurs ' i &
Sons Opérateurs
Stylo Variables

avancer de pas

—p | avancerde pas
tourner de (& degrés

tourner de & degrés

Clique sur le bloc pour faire avancer le chat de 10 pas.

http://scratch.mit.edu




"
dorrdl @ @ D Fichier Edition Partage Aide

alld 'y

Mouvement Contrdle
Apparence Capteurs
Sons Opérateurs
Stylo Varlables

ouer le son miaou |
] - . avancer de i) pas

jouer le son miaou | complétement jouer tambour {TRg pour temps

arréter tous les sons

jouer tambour fT}¢ pour temg

faire une pause pour (¥} temps

Déplace le bloc de commande jouer du tambour ... pour .
assemble le au-dessous du bloc de commande avancer de ...

avancer de i) pas
jouer tambour R pour temps

Clique et écoute.

Si tu n’entends pas le son, vérifie que les
parameétres de son de ton ordinateur sont
corrects.

LIRS ELITN 48| (35) Grosse caisse acoustique
(36) Grosse caisse 1
(37) Side Stick
(38) Caisse claire acoustique
{39) Claguement de main
(40) Caisse électrique muette

Tu peux choisir des sons différents a
partir du menu déroulant.

http://scratch.mit.edu




avancer de i) pas
jouer tambour k4 pour temps
avancer de @i} pas

-

Ajoute un autre bloc de commande avancer de ... pas.
Clique a l'intérieur du bloc et ajoute un signe moins.

avancer de pas
jouer tambour T34 pour
avancer de BT pas

Cligue sur n'importe quel bloc pour
lancer I'exécution de la pile.

avancer de pas

jouer tambour )4 pour temps
avancer de pas

jouer tambour {3Rg pour temps

Ajoute un bloc de commande jouer du tambour ... pour ... temps
ensuite choisis un autre son et clique pour exécuter.

http://scratch.mit.edu



St &b @ D Fichier Edition Partage Aide

S

Mouvement Contrile

Apparence Capteurs
Sons Opérateurs

Stylo Varlables

‘vqu.lnd pressé

quand 8space | est pressé

,‘ quand Lutinl pressé

/
_;ﬁndn €Y secondes /

/

répéter indéfinimant

-t

Lutinl

répéter irdéfiniment

; y _— Y
avancer de i) pas

jouer tambour R4 pour temps

avancer de (§T) pas

Déplace un bloc de commande oo ndatiniment et place-le sur le

dessus de la pile.

La bouche du bloc de commande = cicr incatiniment entoure les

autres blocs.

:i_piur indéfiniment
avancer de pas
jouer tambour EERG pour temps
avancer de BT} pas
jouer tambour pour temps

Q —

http://scratch.mit.edu

Clique pour exécuter.

Tu peux cliquer sur n'importe
quel bloc pour exécuter la pile .

Pour arréter, clique sur le bouton
stop en haut de I'écran.




AR A" [’Uj-_[ «2 B 8 Fichier Edition Partage Aide

Mouvement Contrdle Lutini

Apparence Capteurs

Sons Opérateurs

Stylo Variables

quand pressé —" quand pressé

_riT:ﬂur indéfiniment
avancer de pas
jouer tambour ETRg pour temps
avancer de (BT pas

jouer tambour pour temps
» =

quand espace | est pressé

quand Lutinl pressé

attendre §§ secondes

Déplace le bloc de commande et assemble-le sur le
dessus de la pile.

dotror] & E D File Edit Share Help

Motion Control

Looks Sensing

Sound Dperators

e SSHRHIES Chaque fois que tu cliques sur
le drapeau vert, ton script va
s'exécuter.

when clicked

Pour arréter, clique sur le

bouton d'arrét.

http://scratch.mit.edu
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